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Adobe® Acrobat® 9 - New PDF Portfolio Layouts 
  
Welcome to the Adobe Acrobat 9 – PDF Portfolio Layouts ReadMe, which contains 
essential information on how to install the updated and new Acrobat 9 PDF Portfolio 
layouts. 
 
For Adobe Acrobat 9 product support information, see: 
http://www.adobe.com/go/acrobat_support 
 
These layouts are available for installation: 


• New layouts: 
o Grid with File Preview – Adds quick previews to Basic Grid 
o Grid with Sidebar – Adds quick navigation to Basic Grid 
o Grid with Size Options – Adds description and icon sizes to Basic Grid 
o List with File Preview – Adds quick previews to List View 
o Sliding Row with Sidebar – Adds quick navigation to Sliding Row 


• Updated layouts: 
o On an Image – Arrange files on top of any image 
o Revolve – Bring one file into focus at a time 
o Sliding Row – Display files in a row 


System Requirements 


Adobe Acrobat 9 Professional or Pro Extended must be installed on your system before 
you install these PDF Portfolio layouts. 


Before Beginning Installation  


You should currently have the PDF Portfolio Acrobat9Layouts_efgj.pdf open in Acrobat 
9.  Before starting installation, you may want to open this ReadMe file in a new Acrobat 
window by clicking the Open button, so that you can see these instructions as you install 
the layout files. 


Installation Instructions 


To install for Windows® XP 


1. First make sure you can see hidden files and folders on your computer: 
a. On the Tools menu in Windows Explorer, choose Folder Options. 
b. Select the View tab. 
c. Under Hidden files and folders, make sure Show hidden files and folders 


is selected (click it if it is not). 
d. Click OK. 



http://www.adobe.com/go/acrobat_support�
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2. In the Acrobat 9 PDF Portfolio window, click the Home icon in the toolbar to 
return to the home view of all folders. 


3. Find the folder for the language you want to install, and double-click it to open 
the layouts folder. The language must be the same as your Acrobat 9 installation.  


4. Hold the Ctrl key on your keyboard and select all .nav files in the layouts folder. 
5. Go to the Start menu on your computer and select My Computer. 
6. Browse to this folder location:  


<system drive>:\Documents and Settings\<username>\Application 
Data\Adobe\Acrobat\9.0\Navigators 


7. If you do not see the Navigators folder, create a new folder called Navigators. 
8. Drag the selected .nav files from Acrobat 9 to this location in Windows Explorer. 


To install for Windows® Vista 


1. First make sure you can see hidden files and folders on your computer: 
a. Click the Start button. 
b. Click the Control Panel option. 
c. When the Control Panel opens 


 
If you are in the Classic view:  


1. Double-click on the Folder Options icon. 
2. Select the View tab. 
3. Under Hidden files and folders, make sure Show hidden files and 


folders is selected (click it if it is not). 
4. Click OK. 


If you are in the Control Panel Home view:  


1. Click the Appearance and Personalization link. 
2. Under Folder Options, select Show hidden files or folders. 
3. Select on the View tab 
4. Under Hidden files and folders, make sure Show hidden files and 


folders is selected (click it if it is not). 
5. Click OK. 


2. In the Acrobat 9 PDF Portfolio window, click the Home icon in the toolbar to 
return to the home view of all folders. 


3. Find the folder for the language you want to install, and double-click it to open 
the layouts folder. The language must be the same as your Acrobat 9 installation. 


4. Hold the Ctrl key on your keyboard and select all .nav files in the layouts folder. 
5. Go to the Start menu on your computer and select Computer. 
6. Browse to this folder location:  


<system 
drive>:\Users\<username>\AppData\Roaming\Adobe\Acrobat\9.0\Navigators 


7. If you do not see the Navigators folder, create a new folder called Navigators. 
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8. Drag the selected .nav files from Acrobat 9 to this location in Windows Explorer. 


To install for Mac OS® 


1. In the Acrobat 9 PDF Portfolio window, click the Home icon in the toolbar to 
return to the home view of all folders. 


2. Find the folder for the language you want to install, and double-click it to open 
the layouts folder. The language must be the same as your Acrobat 9 installation.  


3. Hold the Command key and select all .nav files in the layouts folder. 
4. Open Finder. 
5. Browse to this location: /Applications/Adobe Acrobat 9 Pro/Adobe Acrobat Pro 
6. Hold the Ctrl key and select the Adobe Acrobat Pro application.  Choose Show 


Package Contents. 
7. Browse to this folder location in the Adobe Acrobat Pro application: 


/Contents/Resources/en.lproj/Navigators  
8. Drag the selected .nav files from Acrobat 9 to this location in Finder. 
9. If prompted to replace the existing files, choose Replace. 


To verify that the PDF Portfolio layouts were successfully installed 


1. Restart Acrobat 9. 
2. Select File > Create PDF Portfolio. 
3. In the Edit PDF Portfolio panel under Choose a Layout > Basic Layouts, you 


should now see these navigators: 
a. Basic Grid 
b. Grid with File Preview 
c. Grid with Sidebar 
d. Grid with Size Options 
e. List with File Preview 
f. On an Image 
g. Revolve 
h. Sliding Row 
i. Sliding Row with Sidebar 


Legal Notices 


© 2008 Adobe Systems Incorporated. All rights reserved. Adobe and Acrobat are either 
registered trademarks or trademarks of Adobe Systems Incorporated in the United States 
and/or other countries. Windows is a registered trademark of Microsoft Corporation in 
the United States and/or other countries. Apple, Mac OS, and Safari are trademarks of 
Apple Computer, Inc. registered in the United States and other countries. All other 
trademarks are the property of their respective owners. Updated Information/Additional 
Third Party Code Information available at http://www.adobe.com/go/thirdparty/ 


 Adobe Systems Incorporated, 345 Park Avenue, San Jose, California 95110, USA.  
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Adobe® Acrobat® 9 – Nouvelles dispositions des porte-
documents PDF  
  
Bienvenue dans le fichier Lisezmoi d’Adobe Acrobat 9 portant sur les dispositions des porte-
documents PDF. Ce fichier contient des informations essentielles sur le mode d’installation des 
dispositions, nouvelles ou mises à jour, des porte-documents PDF d’Acrobat 9. 
 
Pour plus de détails sur le support produits d’Adobe Acrobat 9, consultez le 
site :  http://www.adobe.com/go/acrobat_support_fr 
 
Les dispositions suivantes sont disponibles pour l’installation : 


• les nouvelles dispositions : 
o grille avec aperçu des fichiers – ajoute des aperçus rapides à la grille de base 
o grille avec barre latérale – permet une navigation rapide dans la grille de base  
o grille avec options de taille – ajoute une description et des tailles d’icône à la 


grille de base 
o liste avec aperçu du fichier – ajoute des aperçus rapides à la liste avec aperçu du 


fichier  
o alignement avec barre latérale – permet une navigation rapide de l’alignement 


• les dispositions mises à jour : 
o sur une image - organiser les fichiers au-dessus de l’image voulue 
o rotation – mettre au premier plan un fichier à la fois  
o alignement - afficher plusieurs fichiers sur une rangée 


Configuration système requise 


Adobe Acrobat 9 Professional ou Pro Extended doivent être installés sur votre ordinateur, avant 
de procéder à l’installation des dispositions d’un porte-documents PDF. 


Avant de lancer l’installation  


Laissez le porte-documents PDF Acrobat9Layouts_efgj.pdf ouvert dans Acrobat 9. Avant de 
procéder à l’installation, vous pouvez ouvrir le fichier Lisezmoi dans une nouvelle fenêtre 
Acrobat en cliquant sur Ouvrir, de sorte à lire les instructions lors de l’installation des fichiers de 
disposition. 


Instructions d'installation 


Installation pour Windows® XP 
1. Assurez-vous d’abord d’avoir accès aux fichiers et dossiers cachés de votre ordinateur : 


a. dans le menu Outils de l’Explorateur Windows, sélectionnez Options des dossiers 
b. cliquez sur l’onglet Affichage 



http://www.adobe.com/go/acrobat_support_fr�
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c. sous Fichiers et dossiers cachés, assurez-vous que l’option Afficher les fichiers et 
dossiers cachés est bien cochée (cliquez dessus le cas échéant) 


d. cliquez sur OK  
2. Dans la fenêtre d’un porte-documents Acrobat 9, cliquez sur l’icône Racine de la barre 


d’outils pour rendre à l’ensemble des dossiers leurs vues Racine. 
3. Identifiez le dossier contenant la langue que vous souhaitez installer, puis cliquez deux 


fois dessus pour ouvrir le dossier Dispositions. La langue choisie doit être identique à 
celle de votre installation Acrobat 9.  


4. Maintenez la touche Ctrl de votre clavier enfoncée pour sélectionner tous les fichiers .nav 
du dossier Dispositions. 


5. Dans le menu Démarrer de votre ordinateur, sélectionnez Poste de travail. 
6. Recherchez l’emplacement du dossier qui suit :  


<lecteur système>:\Documents and Settings\<nom_utilisateur>\Application 
Data\Adobe\Acrobat\9.0\Navigators\ 


7. Si vous ne pouvez voir le dossier Navigators, veuillez créer un nouveau dossier intitulé 
Navigators. 


8. Faites glisser les fichiers .nav sélectionnés depuis Acrobat 9 vers cet emplacement dans 
l’Explorateur Windows. 


Installation pour Windows® Vista 
1. Assurez-vous d’abord d’avoir accès aux fichiers et dossiers cachés de votre ordinateur : 


a. appuyez sur le bouton Démarrer 
b. cliquez sur l’option Panneau de configuration. 
c. lors de l’ouverture du panneau de configuration 


 
si vous êtes en vue classique :  
 
1. cliquez deux fois sur l’icône Options des dossiers. 
2. cliquez sur l’onglet Affichage. 
3. sous Fichiers et dossiers cachés, assurez-vous que l’option Afficher les 


fichiers et dossiers cachés est bien cochée (cliquez dessus le cas échéant). 
4. cliquez sur OK.  
 
si vous êtes en vue racine du panneau de configuration :  
 
1. cliquez sur le lien Apparence et thèmes. 
2. sous Options des dossiers, sélectionnez Afficher les fichiers et dossiers 


cachés. 
3. cliquez sur l’onglet Affichage. 
4. sous Fichiers et dossiers cachés, assurez-vous que l’option Afficher les 


fichiers et dossiers cachés est bien cochée (cliquez dessus le cas échéant). 
5. cliquez sur OK.  
 


2. Dans la fenêtre d’un porte-documents Acrobat 9, cliquez sur l’icône Racine de la barre 
d’outils pour rendre à l’ensemble des dossiers leurs vues Racine. 
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3. Identifiez le dossier contenant la langue que vous souhaitez installer, puis cliquez deux 
fois dessus pour ouvrir le dossier Dispositions. La langue choisie doit être identique à 
celle de votre installation Acrobat 9. 


4. Maintenez la touche Ctrl de votre clavier enfoncée pour sélectionner tous les fichiers .nav 
du dossier Dispositions. 


5. Dans le menu Démarrer de votre ordinateur, sélectionnez Poste de travail. 
6. Recherchez l’emplacement du dossier qui suit :  


<lecteur système>:\Documents and Settings\<nom_utilisateur>\Application 
Data\Adobe\Acrobat\9.0\Navigators\ 


7. Si vous ne pouvez voir le dossier Navigators, veuillez créer un nouveau dossier intitulé 
Navigators. 


8. Faites glisser les fichiers .nav sélectionnés depuis Acrobat 9 vers cet emplacement dans 
l’Explorateur Windows. 


Installation pour Mac OS® 
1. Dans la fenêtre d’un porte-documents Acrobat 9, cliquez sur l’icône Racine de la barre 


d’outils pour rendre à l’ensemble des dossiers leurs vues Racine. 
2. Identifiez le dossier contenant la langue que vous souhaitez installer, puis cliquez deux 


fois dessus pour ouvrir le dossier Dispositions. La langue choisie doit être identique à 
celle de votre installation Acrobat 9.  


3. Maintenez la touche Ctrl de votre clavier enfoncée pour sélectionner tous les fichiers .nav 
du dossier Dispositions. 


4. Ouvrez le Finder. 
5. Recherchez l’emplacement qui suit : /Applications/Adobe Acrobat 9 Pro/Adobe Acrobat 


Pro 
6. Maintenez la touche Ctrl enfoncée et sélectionnez l’application Adobe Acrobat Pro.   


Choisissez Afficher le contenu du progiciel. 
7. Recherchez l’emplacement du dossier suivant dans l’application Adobe Acrobat Pro : 


/Contents/Resources/fr.lproj/Navigators  
8. Faites glisser les fichiers .nav sélectionnés depuis Acrobat 9 vers cet emplacement dans le 


Finder. 
9. Si vous êtes invité à remplacer les fichiers existants, choisissez Remplacer. 


Comment vérifier que l’installation des dispositions du porte-documents PDF 
ait réussi ? 


1. Redémarrez Acrobat 9. 
2. Choisissez Fichier > Créer un porte-documents PDF. 
3. Dans le panneau Modifier le porte-documents PDF qui se trouve sous Choix d’une 


disposition> Dispositions standard, vous devriez apercevoir les navigateurs suivants : 
a. grille de base 
b. grille avec aperçu des fichiers 
c. grille avec barre latérale 
d. grille avec options de taille 
e. liste avec aperçu du fichier 
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f. sur une image 
g. rotation 
h. alignement 
i. alignement avec barre latérale 


 
Problème connu : pour certaines langues, deux versions de la même disposition peuvent 
s’afficher dans le panneau Modifier le porte-documents PDF. Vous pouvez choisir l’une d’entre 
elles. 


Informations juridiques 


© 2008 Adobe Systems Incorporated. Tous droits réservés. Adobe et Acrobat sont des marques 
ou des marques déposées d'Adobe Systems Incorporated aux Etats-Unis et/ou dans d'autres pays. 
Windows est une marque déposée de Microsoft Corporation aux Etats-Unis et/ou dans d'autres 
pays. Apple, Mac OS et Safari sont des marques d'Apple Computer, Inc., déposées aux Etats-
Unis et dans d'autres pays. Toutes les autres marques citées sont la propriété de leurs détenteurs 
respectifs. Informations actualisées et renseignements supplémentaires sur les codes tiers 
disponibles à l'adresse http://www.adobe.com/go/thirdparty_fr/. 


Adobe Systems Incorporated, 345 Park Avenue, San Jose, California 95110, USA. 
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Adobe® Acrobat® 9 – Neue PDF-Portfoliolayouts 
  
Willkommen bei der Bitte lesen-Datei zum Thema „Adobe Acrobat 9 – PDF-Portfoliolayouts“. 
Diese Datei enthält Informationen zur Installation der aktualisierten und neuen Acrobat 9 PDF-
Portfoliolayouts. 
 
Informationen zum Produkt-Support für Adobe Acrobat 9 erhalten Sie 
unter: http://www.adobe.com/go/acrobatconnect_support_de 
 
Folgende Layouts können installiert werden: 


• Neue Layouts: 
o Raster mit Dateivorschau – Basisraster mit Vorschaubildern 
o Raster mit Seitenleiste – Basisraster mit Schnellnavigationsoption 
o Raster mit Größenoptionen – Basisraster mit Größenoptionen für Beschreibungen 


und Symbole 
o Liste mit Dateivorschau –Listenansicht mit Vorschaubildern 
o Fließende Anzeige mit Seitenleiste - Fließende Anzeige mit 


Schnellnavigationsoption 
• Aktualisierte Layouts: 


o Auf einem Bild –Dateien auf einem beliebigen Bild anordnen 
o Drehen – Nur eine Datei auf einmal aktivieren 
o Fließende Anzeige – Dateien in einer Reihe anzeigen 


Systemanforderungen 


Zur Installation der PDF-Portfoliolayouts muss Adobe Acrobat 9 Professional oder Pro Extended 
auf Ihrem System installiert sein. 


Vor der Installation  


In Acrobat 9 sollte das PDF-Portfolio Acrobat9Layouts_efgj.pdf geöffnet sein. Öffnen Sie diese 
Bitte lesen-Datei vor dem Durchführen der Installation in einem neuen Acrobat-Fenster über die 
Öffnen-Schaltfläche, so dass Sie die Installationsanleitungen der Layout-Dateien zur Hand haben. 


Installationsanweisungen 


Installation unter Windows® XP 


1. Stellen Sie sicher, dass die Option zum Anzeigen versteckter Dateien und Ordner auf 
Ihrem System aktiviert ist. 


a. Wählen Sie im Windows Explorer im Menü „Extras“ den Eintrag 
„Ordneroptionen“. 



http://www.adobe.com/go/acrobatconnect_support_de�
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b. Aktivieren Sie die Registerkarte „Ansicht“. 
c. Aktivieren Sie unter „Versteckte Dateien und Ordner“ die Option zum Anzeigen 


aller Dateien und Ordner (falls deaktiviert). 
d. Klicken Sie auf „OK“. 


2. Klicken Sie in Acrobat 9 im PDF-Portfolio-Fenster auf das Startseiten-Symbol in der 
Werkzeugleiste zum Anzeigen der Startansicht aller Ordner. 


3. Rufen Sie den Ordner der zu installierenden Sprache auf und doppelklicken Sie darauf 
zum Öffnen der Ordner mit den Layouts. Die Sprache muss der der Acrobat 9-Version 
entsprechen.  


4. Wählen Sie bei gedrückter Strg-Taste alle .nav-Dateien im Layoutordner aus. 
5. Wählen Sie im Start-Menü Ihres Computers die Option „Arbeitsplatz“. 
6. Rufen Sie folgendes Verzeichnis auf:  


<Systemlaufwerk>:\Dokumente und 
Einstellungen\<Benutzername>\Anwendungsdaten\Adobe\Acrobat\9.0\Navigators\ 


7. Ist der Ordner „Navigators“ nicht vorhanden, erstellen Sie einen neuen Ordner mit 
diesem Namen. 


8. Ziehen Sie die ausgewählten .nav-Dateien von Acrobat 9 in dieses Verzeichnis im 
Windows Explorer. 


Installation unter Windows® Vista 


1. Stellen Sie sicher, dass die Option zum Anzeigen versteckter Dateien und Ordner auf 
Ihrem System aktiviert ist. 


a. Klicken Sie auf die Start-Schaltfläche. 
b. Öffnen Sie die Systemsteuerung. 
c. Gehen Sie in der Systemsteuerung je nach Ansichtsmodus folgendermaßen vor. 


Klassische Ansicht:  


1. Doppelklicken Sie auf „Ordneroptionen“. 
2. Aktivieren Sie die Registerkarte „Ansicht“. 
3. Aktivieren Sie unter „Versteckte Dateien und Ordner“ die Option zum 


Anzeigen aller Dateien und Ordner (falls deaktiviert). 
4. Klicken Sie auf „OK“. 


Kategorieansicht:  


1. Klicken Sie auf „Darstellung und Designs“. 
2. Nehmen Sie unter „Ordneroptionen“ die Einstellungen zum Anzeigen 


versteckter Dateien und Ordner vor. 
3. Aktivieren Sie dazu die Registerkarte „Ansicht“. 
4. Aktivieren Sie unter „Versteckte Dateien und Ordner“ die Option zum 


Anzeigen aller Dateien und Ordner (falls deaktiviert). 
5. Klicken Sie auf „OK“. 
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2. Klicken Sie in Acrobat 9 im PDF-Portfolio-Fenster auf das Startseiten-Symbol in der 
Werkzeugleiste zum Anzeigen der Startansicht aller Ordner. 


3. Rufen Sie den Ordner der zu installierenden Sprache auf und doppelklicken Sie darauf 
zum Öffnen der Ordner mit den Layouts. Die Sprache muss der der Acrobat 9-Version 
entsprechen. 


4. Wählen Sie bei gedrückter Strg-Taste alle .nav-Dateien im Layoutordner aus. 
5. Wählen Sie im Start-Menü Ihres Computers die Option „Arbeitsplatz“. 
6. Rufen Sie folgendes Verzeichnis auf:  


<Systemlaufwerk>:\Users\<Benutzername>\AppData\Roaming\Adobe\Acrobat\9.0\Navi
gators 


7. Ist der Ordner „Navigators“ nicht vorhanden, erstellen Sie einen neuen Ordner mit 
diesem Namen. 


8. Ziehen Sie die ausgewählten .nav-Dateien von Acrobat 9 in dieses Verzeichnis im 
Windows Explorer. 


Installation unter Mac OS® 
1. Klicken Sie in Acrobat 9 im PDF-Portfolio-Fenster auf das Startseiten-Symbol in der 


Werkzeugleiste zum Anzeigen der Startansicht aller Ordner. 
2. Rufen Sie den Ordner der zu installierenden Sprache auf und doppelklicken Sie darauf 


zum Öffnen der Ordner mit den Layouts. Die Sprache muss der der Acrobat 9-Version 
entsprechen.  


3. Wählen Sie bei gedrückter Befehlstaste alle .nav-Dateien im Layoutordner aus. 
4. Öffnen Sie den Finder. 
5. Rufen Sie folgendes Verzeichnis auf: /Programme/Adobe Acrobat 9 Pro/Adobe Acrobat 


Pro 
6. Wählen Sie die Anwendung Adobe Acrobat Pro bei gedrückter Strg-Taste aus.  Klicken 


Sie auf „Paketinhalt zeigen“. 
7. Rufen Sie das folgende Verzeichnis in Adobe Acrobat Pro auf: 


/Contents/Resources/de.lproj/Navigators  
8. Ziehen Sie die ausgewählten .nav-Dateien von Acrobat 9 in dieses Verzeichnis im Finder. 
9. Wenn Sie zum Ersetzen der vorhandenen Dateien aufgefordert werden, wählen Sie 


„Ersetzen“. 


So überprüfen Sie die Installation der PDF-Portfoliolayouts 


1. Starten Sie Acrobat 9 neu. 
2. Wählen Sie „Datei“ > „PDF-Portfolio erstellen“. 
3. Rechts im Bereich „PDF-Portfolio bearbeiten“ sollten nun unter „Layout 


wählen“  > „Einfache Layouts“ folgende Einträge angezeigt werden: 
a. Basisraster 
b. Raster mit Dateivorschau 
c. Raster mit Seitenleiste 
d. Raster mit Größenoptionen 
e. Liste mit Dateivorschau 
f. Auf einem Bild 
g. Drehen 







4 
 


h. Fließende Anzeige 
i. Fließende Anzeige mit Seitenleiste 


 
Bekanntes Problem: Bei einigen Sprachen werden eventuell zwei Versionen desselben Layouts 
im Fenster „PDF-Portfolio bearbeiten“ angezeigt. Beide können verwendet werden 


Rechtliche Hinweise 


© 2008 Adobe Systems Incorporated. Alle Rechte vorbehalten. Adobe und Acrobat sind 
eingetragene Marken oder Marken von Adobe Systems Incorporated in den USA und/oder 
anderen Ländern. Windows ist eine eingetragene Marke der Microsoft Corporation in den USA 
und/oder anderen Ländern. Apple, Mac OS und Safari sind Marken von Apple Computer Inc., 
die in den USA und anderen Ländern eingetragen sind. Alle anderen Marken sind Eigentum ihrer 
jeweiligen Inhaber. Aktualisierte Informationen und zusätzliche Angaben zu Drittanbietercode 
stehen unter http://www.adobe.com/go/thirdparty_de/ zur Verfügung. 


Adobe Systems Incorporated, 345 Park Avenue, San Jose, California 95110, USA. 
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Adobe® Acrobat® 9 - 新しい PDF ポートフォリオレイ


アウト 
  


Adobe Acrobat 9 - PDF ポートフォリオレイアウトをダウンロードいただき、誠にあり


がとうございます。このドキュメントには、新規および更新された Acrobat 9 
PDF ポートフォリオレイアウトをインストールする方法についての重要な情報


が記載されています。 


 


Adobe Acrobat 9 製品のサポート情報について詳しくは、


http://www.adobe.com/go/acrobat_support_jp を参照してください。 


 


次のレイアウトをインストールすることができます。 


 新規のレイアウト： 


o グリッド (ファイルプレビュー付き) - 基本グリッドにクイックプレ


ビューを追加します。 


o グリッド (サイドバー付き) - 基本グリッドにクイックナビゲーショ


ンを追加します。 


o グリッド (サイズオプション付き) - 基本グリッドに説明とアイコン


サイズを追加します。 


o リスト (ファイルプレビュー付き) - リスト表示にクイックプレビュ


ーを追加します。 


o 横にスライド (サイドバー付き) - 横にスライド表示にクイックナビ


ゲーションを追加します。 


 更新されたレイアウト： 


o 背景に画像 - 任意の画像上にファイルを配置します。 


o 回転 - 一度に 1 つのファイルだけにフォーカスをあてます。 


o 横にスライド - ファイルを連続して表示します。 
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必要システム構成 


これらの PDF ポートフォリオレイアウトをインストールする前に、


Adobe Acrobat 9 Professional または Pro Extended をシステムにインス


トールしていなければなりません。 


インストールを開始する前に 


Acrobat 9 で PDF ポートフォリオ Acrobat9Layouts_efgj.pdf を開いてい


る必要があります。インストールを開始する前に、「開く」ボタン


をクリックして、このドキュメントを新しい Acrobat ウィンドウで開


き、レイアウトファイルをインストールするときにこれらの手順を


確認できるようにします。 


インストール手順 


Windows® XP にインストールするには 


1. 最初に、コンピュータで非表示のファイルとフォルダを表示できることを


確認します。 


a. Windows エクスプローラのツールメニューで「フォルダ オプショ


ン」を選択します。 
b. 「表示」タブを選択します。 
c. 「ファイルとフォルダの表示」で「すべてのファイルとフォルダを


表示する」がオンになっていることを確認します（オンになってい


ない場合は、この時点でオンにします）。 
d. 「OK」をクリックします。 


2. Acrobat 9 PDF ポートフォリオのウィンドウで、ツールバーのホームアイ


コンをクリックし、すべてのフォルダのホームビューに戻ります。 


3. インストールする言語のフォルダを見つけ、ダブルクリックしてレイアウ


トフォルダを開きます。この言語は、インストールする Acrobat 9 の言語


と同じでなければなりません。  


4. キーボードの Ctrl キーを押したまま、layouts フォルダのすべての .nav フ
ァイルを選択します。 


5. コンピュータのスタートメニューから「マイ コンピュータ」を選択しま


す。 


6. 次のフォルダの場所に移動します。  
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<システムドライブ>:\Documents and Settings\<ユーザ名>\Application 
Data\Adobe\Acrobat\9.0\Navigators\ 


7. Navigators フォルダが見当たらない場合、「Navigators」という名前のフ


ォルダを新しく作成してください。 


8. 選択した .nav ファイルを、Acrobat 9 から Windows エクスプローラのこの


場所までドラッグします。 


Windows® Vista にインストールするには 


1. 最初に、コンピュータで非表示のファイルとフォルダを表示できることを


確認します。 
a. 「スタート」ボタンをクリックします。 
b. 「コントロール パネル」オプションをクリックします。 
c. コントロールパネルが開いたら、次の手順を実行します。 


 


クラシック表示の場合：  


1. フォルダ オプションアイコンをダブルクリックします。 
2. 「表示」タブを選択します。 
3. 「ファイルとフォルダの表示」で「すべてのファイルとフォルダを


表示する」がオンになっていることを確認します（オンになってい


ない場合は、この時点でオンにします）。 
4. 「OK」をクリックします。 


コントロール パネル ホーム表示の場合：  


1. 「デスクトップのカスタマイズ」リンクをクリックします。 
2. 「フォルダ オプション」で「ファイルとフォルダの表示」


を選択します。 
3. 「表示」タブを選択します。 
4. 「ファイルとフォルダの表示」で「すべてのファイルとフォ


ルダを表示する」がオンになっていることを確認します（オ


ンになっていない場合は、この時点でオンにします）。 
5. 「OK」をクリックします。 


2. Acrobat 9 PDF ポートフォリオのウィンドウで、ツールバーのホームアイ


コンをクリックし、すべてのフォルダのホームビューに戻ります。 


3. インストールする言語のフォルダを見つけ、ダブルクリックしてレイアウ


トフォルダを開きます。この言語は、インストールする Acrobat 9 の言語


と同じでなければなりません。 
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4. キーボードの Ctrl キーを押したまま、layouts フォルダのすべての .nav フ
ァイルを選択します。 


5. コンピュータのスタートメニューから「コンピュータ」を選択します。 


6. 次のフォルダの場所に移動します。  


<システムドライブ>:\Users\<ユーザ名
>\AppData\Roaming\Adobe\Acrobat\9.0\Navigators 


7. Navigators フォルダが見当たらない場合、「Navigators」という名前のフ


ォルダを新しく作成してください。 


8. 選択した .nav ファイルを、Acrobat 9 から Windows エクスプローラのこの


場所までドラッグします。 


Mac OS® にインストールするには 


1. Acrobat 9 PDF ポートフォリオのウィンドウで、ツールバーのホームアイ


コンをクリックし、すべてのフォルダのホームビューに戻ります。 


2. インストールする言語のフォルダを見つけ、ダブルクリックしてレイアウ


トフォルダを開きます。この言語は、インストールする Acrobat 9 の言語


と同じでなければなりません。  


3. Command キーを押したまま、layouts フォルダのすべての .nav ファイルを


選択します。 


4. ファインダを開きます。 


5. /アプリケーション/Adobe Acrobat 9 Pro/Adobe Acrobat Pro に移動します。 


6. Ctrl キーを押したまま Adobe Acrobat Pro アプリケーションを選択します。


「パッケージコンテンツを表示」を選択します。 


7. Adobe Acrobat Pro アプリケーションで次のフォルダの場所に移動します。 


/Contents/Resources/ja.lproj/Navigators  


8. 選択した .nav ファイルを、Acrobat 9 からファインダのこの場所までドラ


ッグします。 


9. 既存のファイルの置き換えを求めるメッセージが表示されたら、「置換」


を選択します。 


PDF ポートフォリオレイアウトが正しくインストールされたことを


確認するには 


1. Acrobat 9 を再起動します。 


2. ファイル／PDF ポートフォリオを作成を選択します。 


3. レイアウトを選択／基本レイアウトの「PDF ポートフォリオを編集」パ


ネルに次のナビゲータが表示されます。 
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a. 基本グリッド 


b. グリッド (ファイルプレビュー付き) 


c. グリッド (サイドバー付き) 


d. グリッド (サイズオプション付き) 


e. リスト (ファイルプレビュー付き) 


f. 背景に画像 


g. 回転 


h. 横にスライド 


i. 横にスライド(サイドバー付き) 


 


既知の問題：一部の言語では、同じレイアウトを持つ PDF ポートフォリオを編


集パネルが 2 つ表示されることがあります。どちらかを選んで使用できます。 


法律上の注意事項 
© 2008 Adobe Systems Incorporated. All rights reserved. Adobe and Acrobat are either 
registered trademarks or trademarks of Adobe Systems Incorporated in the United States 
and/or other countries. Windows is a registered trademark of Microsoft Corporation in 
the United States and/or other countries. Apple, Mac OS, and Safari are trademarks of 
Apple Computer, Inc. registered in the United States and other countries. All other 
trademarks are the property of their respective owners. Updated Information/Additional 
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